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WINDOWS 95 
 
Basic Instructions  

• Startup and Shutdown 
• Taskbar 
• Minimize, Maximize, Exit Application 
• Changing the Desktop and Screen Savers 
• My Computer Icon 
• Create Folder  
• Emptying the Recycle Bin 

 
Troubleshooting  

• Ten Things to Check 
• Application Stops Responding 
• Computer Hangs Up 
• Can’t Boot to Safe Mode 
 



 
 
Startup and Shutdown 
 
Windows 95 is the operating system that starts automatically when you turn on your computer. 
 
Before turning off your computer, you should follow the Windows 95 shut down procedure: 
 

Click the Start button 
 

Click Shut Down 
 

Select the Shut down the computer? 
 

Select Yes and wait until you are told that it is safe to turn off the computer. 
 
Taskbar 
 
The taskbar refers to the bar across the bottom of your screen.  Buttons, representing running applications, 
appear whenever you start a program or open a window.  To switch between applications, click the button 
on the taskbar that represents the application you want to open.  When you close the window, the button 
associated with the opened application disappears from the taskbar. 
 
You can open a second application by clicking the Start button while in an application and selecting 
another program. 
 
If you minimize applications, the Windows 95 taskbar displays all minimized applications as buttons.  You 
can click on an open, minimized application button at any time and switch quickly between applications. 
 
You can close an active application on the taskbar if you right-click the application name and select Close. 
 
Minimize, Maximize, Exit Application 
 
In the top, right-hand corner of the screen: 
• You minimize an application screen by clicking on the button with a dash. 
• You maximize a screen by clicking on the button with a box. 
• You exit an application by clicking on the button with an X. 
• You can restore a screen by clicking on the double box button. 
 
 
Changing the Desktop and Screen Savers  
 
Click on Start 
Click on Settings 
Double-click on Control Panel 
Double-click on Display 
Click the Background Tab at the top 
Select the background wallpaper desired 
Click Apply 
Click the Screen Saver Tab at the top 
Select the screen saver desired 
Click Apply 
Click OK 
 



My Computer Icon 
 
You can use My Computer to view and quickly access any resources available to your computer, such as 
folders and files located on your hard drive, diskette drive, or any network drive to which you have access.  
The My Computer windows also displays an icon for the Control Panel and Printer folder. 
 
You can also see the folders and files on your hard drive by going to Start, then do a right-click  of the 
mouse, then go to Explore. 
 
Copy Files to a Diskette 
Insert diskette in drive – 3 ½ drive 
Click on My Computer icon 
Click on the C: drive or the D: drive (depending on where your files are saved) 
If you are using Microsoft Office applications – Word, Excel, Access, or PowerPoint – Click on the folder 
labeled My Documents 
Locate the file you wish to copy – right-click on the file 
Click Send To 
Click 3 ½ drive 
A window will open up and show a sheet of paper going from one folder to another.  This indicates that 
your file is being copied. 
 
Copy Files or Folders 
There are a number of different ways to copy files and folders in Explorer: 
1. the shortcut menu (right-click for the menu) 
2. the Edit pull-down menu  
3. the drag and drop method 
 
The shortcut menu – 
• See the steps in Copy Files to a Diskette 
 
The Edit pull-down menu – 
• In My Computer window or Explorer window, click on the file or folder you want to copy. 
• On the Edit menu, click Copy 
• Open the folder or disk where you want to put the copy 
• On the Edit menu, click Paste 
 
The drag and drop method – 
• In My Computer window or Explorer window, click and hold the click on the file or folder you want to 

copy. 
• Drag the file to the 3 ½ drive 
 
To be sure that you are copying instead of moving, make sure that a plus (+) symbol appears when you are 
dragging the file or folder. 
 
Create a Folder in Windows Explorer 
• Select the drive or folder in the tree in which you want to create the new folder – most of the time you 

will want to put the folder under or in the folder called “My Documents” 
• Click on File 
• Click on New 
• Select Folder 
• Enter a name for the folder 
• Press Enter 



Emptying the Recycle Bin 
 
When you drag files, folders, and icons into the Recycle Bin, they disappear from your desktop, but they're 
not immediately deleted (a handy feature if you later want to get something back that you've thrown away). 
Emptying the Recycle Bin is like taking your empty bottles to your local recycler--once you do, they're 
really gone, and you get more free space in your garage--that is, your hard disk. 
 
Emptying the Recycle Bin is a snap. Choose one of the following methods: 
• Right-click the Recycle Bin icon and choose Empty Recycle Bin. 
Or 
• Open the Recycle Bin and choose File Empty Recycle Bin. 
 
If you're not sure you want to permanently get rid of all of the files, opt for the second choice and scan the 
list of deleted files before you empty the bin. 
 
If you add more files than Recycle Bin can hold--if the files in the bin exceed the disk space you've 
assigned to the bin--the bin will make room by deleting the files that have been in it the longest. 
 



Troubleshooting your computer - Ten things to try before calling for help: 
 
1. Restart your computer 

2. Figure out if it’s a hardware or software problem. 

3. Tighten all cable connections. 

4. Plug the computer into a different outlet. 

5. Bypass the power strip. 

6. Check the monitor’s contrast/brightness controls. 

7. Listen for beeps and noises. 

8. Check the keyboard 

9. Determine whether the disk is damaged. 

10. Check the printer. 

 



Application Stops Responding 
 
It's unlikely but still possible that a bug in an application will cause it to stop responding or "hang." If this 
happens, you won't be able to choose menu commands in that application, but you will still be able to 
choose menu commands in other applications. You may not be able to move the mouse pointer or click the 
mouse, or the mouse pointer may look like an hourglass or disappear completely.  
 
When this happens, you have some options: 
 
Try patience 
 
The application may actually be busy working on something you told it to do, such as saving a document to 
a disk. The application may also be working on something you didn't tell it to do. For example, a word 
processor application might be busy breaking a long document into pages. 
 
Terminate the hung application 
 
If you've taken a short break and the application is still not responding, press Ctrl+Alt+Del. This tells 
Windows 95 to look at each of the applications you've started, check for responsiveness, and display the 
Close Program dialog box. In the Close Program dialog box, select the application that is not responding 
and click the End Task button. 
 
Close the application 
 
Sometimes an application asks Windows 95 to do the impossible. When Windows 95 alerts you to an 
application error, it usually gives you two choices: Close and Details. You probably want to choose Close. 
(Details just give you the gory specifics of what caused the application to hang.) 
 
In some instances, Windows 95 may give you the option of ignoring the error. The most prudent choice is 
to close the application. But if you've been working with a document and have made changes you haven't 
yet saved, ignore the application error, save the document using a new file name (so you don't replace the 
previous version of the document with a new, possibly corrupted version), and then close the application. 



Computer Hangs when starting in 95 
 
If you have installed Windows 95 and your machine hangs when you try to start it, you can check--and 
correct--several things that may be causing the problem. It could be a device driver that loads from the 
CONFIG.SYS or SYSTEM.INI file, a TSR (memory-resident program) that loads from the 
AUTOEXEC.BAT file, or your video driver. 
 
Track down the Problem 
Press the F8 key when you see the Starting Windows 95 message, and then choose Safe Mode from the list 
of startup options. 
 
If your computer boots in Safe Mode, you need to take further steps to eliminate the source of the problem.  
 
These steps include 
♦ Changing your video driver to Standard VGA. 
♦ Removing any network components if you are on a network. 
 
Change your video driver to Standard VGA 
1. Click the Start button, move the mouse over Settings, and click Control Panel. 
2. Double-click the Display icon. 
3. Click the Settings tab, click the Change Display Type button, and then click the Change button to the 

right of Adapter Type. 
4. Click Show All Devices, and then click (Standard display types) in the Manufacturers list. 
5. Double-click Standard Display Adapter (VGA). 
 
Remove network components 
1. Right-click the Network Neighborhood icon and then click Properties. 
2. Click the client(s) you have installed and then click the Remove button.  
3. Restart your computer when prompted. 



Can’t Boot to Safe Mode  
 
If you've had problems starting your computer with Windows 95 and haven't been able to get Windows 95 
to boot properly even when you choose Safe Mode, restart the computer and press F8 when you see the 
Windows logo. From the menu of booting options, choose Boot to MS-DOS. Then, working from the MS-
DOS prompt, try the following: 
 
Disable Virus Checking and/or ROM BIOS Shadowing 
 
If your computer supports ROM BIOS shadowing or has built-in virus checking, disable them. For 
instructions on how to do this, consult your owner's manual or contact the hardware manufacturer. 
 
Check for Viruses  
 
If you installed Windows 95 over a previous installation of MS-DOS, you can boot to MS-DOS by pressing 
F4 when you see the Starting Windows 95 message. Then, run ScanDisk from the MS-DOS prompt by 
changing to the Windows\Command directory and typing "scandisk." 



E-MAIL 
 
Outlook Instructions 
Configurations Instructions 



Outlook  E-Mail Instructions 
 
 
 
OPEN and READ your messages: 

1. Double-click a mail message to open it. 
2. To read the next or previous mail message in the Inbox, click the Previous Item or the Next 

Item button on the toolbar.  Or, you can open the View menu, choose Previous or Next, and 
choose Item. 

 
COMPOSE a message: 

1. In the Inbox, click the New Mail Message button or choose Compose, New Mail Message.  
The untitled message window appears. 

2. Enter the name of the recipient in the To text box. 
3. In the Subject text box, enter the subject of the message. 
4. Click in the text area, and then enter the text of your message. 
5. When you finish typing your message, you can send the message immediately by clicking the 

Send icon. 
 
SEND mail: 

Click the Send button. 
 
PRINT a message: 

1. Open the message. 
2. Click the Print button on the toolbar to print. 
3. In the Print dialog box, click OK to print one copy of the entire message. 

 
CLOSE a message: 

Choose File, Close or click the Close (x) button in the title bar of the message window. 
 
DELETE an e-mail message: 
 To delete an e-mail message that is open, do one of the following: 

• Choose Edit, Delete 
• Press Ctrl + D 
• Click the Delete button on the toolbar 

 
ANSWER OR REPLY to a message: 

1. Open the message you received, click the Reply button, or choose Compose, Reply. 
2. The insertion point is in the message text area, ready for you to enter your reply.  Enter the 

text. 
3. When you finish your reply, click the Send button. 

 
FORWARD a message: 

1. Select or open the message you want to forward.  Then click the Forward button.  The FW 
Message dialog box appears. 

2. In the To text box, enter the names of the people to whom you want to forward the mail.   
3. If you want to CC, enter the names of anyone to whom you want to forward copies of the 

message. 
4. In the message area of the window, enter any message you want to send with the forwarded 

text.  The text you type will be a different color. 
5. Click the Send button. 

 
 
 
 



ATTACH A FILE to a message: 
1. Type your message as usual, in the message window, position the insertion point in the 

message text, and then choose Insert, File or click the Insert File toolbar button.  The Insert 
File dialog box appears. 

2. From the Look In drop-down list, choose the drive and folder that contains the file you want 
to attach. 

3. Using the Files of Type drop-down list, choose the file type- such as Excel or Word. 
4. From the List box, select the file you want to attach. 
5. Click OK to insert the file into the message. 
6. Then click send as usual. 

 
SAVE AN ATTACHMENT: 
 A paper clip icon beside the message represents an attachment.  You’ll want to save any 
attachments sent to you so that you can open, modify, print, or otherwise use the document. 

1. Open the message containing an attachment by double-clicking the message.  The attachment 
appears as an icon in the message text. 

2. (Optional) You can open the attachment from within the message by double-clicking the icon.  
The application in which the document was created (Word or Excel) opens and displays the 
document in the window. 

3. In the message, select the attachment you want to save and choose File, Save Attachment. 
4. Choose the folder in which you want to save the attachment and click Save. (Hint – remember 

what folder you saved the attachment in!) 
 
ADD NAMES TO CONTACT OR ADDRESS BOOK 

1. Click File, New, Contact from anywhere in Outlook.  The Contact dialog box appears. 
2. Enter contact information in the boxes as indicated. Most important would be person’s name 

and e-mail address.  Determine what category you want the person to be in. 
3. To add a new category at this time, click categories. 
4. Click master category list. 
5. Key in new category. 
6. Click add, then OK. 
7. Click on the category you just added. 
8. Click OK. 
9. Name will be added to that category. 

 
 
CREATE FOLDER FOR MESSAGES 

1. Click File, Folder, Create subfolder. 
2. Key in name of new folder. 
3. Click OK. 
 
 

MOVE MESSAGES TO FOLDER 
1. Open the item you want to move. 
2. Choose Edit, Move to Folder.  The Move Items dialog box appears. 
3. Select the folder to which you want to move the message. 
4. Click OK.  When you close the item, Outlook stores it in the designated folder. 
 

 
 



TO CONFIGURE A  PC FOR YOUR E-MAIL 

 
1. Click on the TOOLS menu and select option SERVICES.  The services window will 

appear. 
 
2. Choose PROPERTIES to change existing e-mail.  A new window will pop up!  
 
 
3. “User Information” is filled in as needed.  Your address is the 1st initial and first six letters of 

your last name followed by “@den.k12.de.us”.  Reply is the same. 
 
 
4. Under “Servers” tab type in “den.k12.de.us” in both the server boxes.  
 

5. Account name is the first part of your address.  DO NOT enter your password.  If you do – it will 
be there permanent.    Click “OK” to finish. 

 
6. You’ll need to exit Outlook for changes to take effect.  Go to File, then Exit.  Then Go to Start, 

Shut Down, then click Restart Computer. 
 
 



File Management 
 
Files 
• Can’t Open a File 

• Save File to Diskette 

• Can’t Save a File 

• Deleting a File or Folder 
• Formatting Disks 



• Can’t Open a File 
 
A file failing to open when you expect it to can be puzzling or even alarming, no doubt about it. But there 
are not too many reasons for a file refusing to open and, unless the file is outright damaged, the reasons are 
easy to address. Here's what you should do: 
 
Verify that the file isn't already open 
 
It's possible that another application has already opened the file. If that's the case, close the document from 
within the application that already has it open. 
 
Use an application instead of Windows Explorer 
 
If you are opening a document created by an MS-DOS application or an application created under an earlier 
version of Windows, use the application to open the document instead of Windows Explorer. Such 
applications may expect a "short" file name where Windows Explorer furnishes a "long" file name. If so, 
the application will tell you that it can't open a file with a name like the one Windows Explorer has 
supplied. 



To save your documents from Office to a diskette 
 

1. Go to Windows Explore.  How? Go to Start, go to Programs, go to Windows Explore. 
2. Put a floppy disk in the drive. 
3. Move the arrow down until you see the folder “My Documents” 
4. Drag that folder up to the 3 ½ floppy drive (a:) 
5. A window will open and show files being copied to the floppy. 



Formatting Disks 
 
Before you can use a floppy disk, it needs to be formatted. You can buy pre-formatted disks, but if the disk 
you have hasn't been formatted yet, you'll need to format it. When you format a disk, you erase all the 
information on the disk. So make sure that you have backups of files you want to save. 
 
To format a floppy disk 
 
1. Insert the disk you want to format in the floppy disk drive. 
2. Double-click the My Computer icon, and then click the drive that has the disk you want to format. 
3. Choose Format from the File menu. 
 
Like most other tasks, Windows 95 offers alternate ways to format disks. You can also format by right-
clicking the mouse. 
 



Deleting a file or a folder 
 
To delete an item or a group of items, select what you want to delete and press the Del key. However, you 
can also 
 
• Right-click an item and choose Delete from the shortcut menu. 
• Select an item or group of items, pull down the folder window's File menu, and choose Delete. 
• Select an item or group of items, and drag it to the Recycle Bin icon on your desktop--or to a shortcut 

for Recycle Bin. 
 
Windows 95 always prompts you to confirm your intent. This protects you from accidental erasures. 
When you delete an item, it is automatically placed in Recycle Bin for what amounts to temporary storage 
in case you change your mind. 
 
Deleted files stay in Recycle Bin until you empty it, or until you exceed its capacity. (Once its capacity is 
reached, Recycle Bin makes room for newly deleted files by permanently deleting the oldest files from the 
bin.) While deleted files are in the bin, you can still retrieve them; however, once you empty the bin, the 
files are permanently deleted. 
 
To empty Recycle Bin, right-click it, and then choose Empty Recycle Bin from the shortcut menu. 



Can’t Save a File 
 
Getting a message that your application can't save your file is alarming, but you have a few steps available 
to you when this happens. Try the following remedies: 
 
Close any other applications 
 
Because applications need a certain amount of system resources to save files, you may have to free up your 
system resources to save a document. Close other applications, and then resave the document. 
 
Close any documents you don't need to save  
 
If you've opened other documents in the same application that won't save the important document, free up 
system resources by closing these other documents. 
 
Try saving using a new file name 
 
Sometimes an application won't let you save a file using a certain file name--for example, if you might 
overwrite another file. Try saving the file using a new file name instead. 
 
Try copying and pasting to another application 
 
If possible, select text or graphics in the application, copy it, and paste it into another application or into a 
new document created by the same application. 



Networking 



Change Your Network Password 
 
Passwords are case sensitive.  That means if you type a letter as a capital, you must enter it as a capital. 
 
1. Click and hold on START. 

2. Select SETTINGS. 

3. Select CONTROL PANELS.  Click to open. 

4. Double click on PASSWORDS  (keys icon). 

5. Click on CHANGE OTHER PASSWORDS. 

6. Click to highlight MCROSOFT NETWORKING. 

7. Click on CHANGE. 

8. Type in your old password.  Then type your new password on each of the two lines below. 

9. Click on OK. 

10. You will see a window that says that your password has been successfully changed. 

11. Click OK.  Then close any open windows. 

12. You now have a new password. 

 



NT Questions 
 
• Someone else’s name is on my computer. How do I log on?  

 Type your user name in the account. Your user name is the first part of your email 
address, or first initial and first six letters of your last name for those with Den 
addresses. Click tab, and add your password. 

 
• How do I change my password?   

 Log on using the old password first.  Hold down the CTRL and ALT keys with one 
hand, and click on delete.  A “change password” button will appear in the dialogue 
box. Click this, and type in the old password. Hit tab and type in the new pass word 
once. Hit tab again, and type in the new password a second time. A box will pop up to 
ok.   

 
• I changed my password, but I can’t log onto my machine.   

You may have mistyped the new password.  Hit enter after typing in the account 
name, and change the password again. 

 
 
• I can’t see teacher share, What happened?  

The server was probably busy when you logged on, and your CPU reverted to a 
profile stored on your machine’s local memory. Reboot, or restart and your teacher 
share should be visible. To reboot a computer, click on start and choose shutdown.  
Choose the restart option. 

 
• I got a message when I logged on that said “ Do you want to use a local or roaming 

profile?”  
Always choose the roaming profile, as this is fresh from the server.  If you don’t, you 
won’t see teacher share. 

 
 
• My HP printer won’t print. 

First, check your cartridge. Second, check all cords, including the cable that screws 
into the back of your CPU. 

 
• I can’t reach the Internet.   

Check to make sure the Internet cord is secure, and then Reboot, or restart the 
computer. If this doesn’t work, the state server may be down. 
 

 
• I’m not receiving messages in outlook mail. 

Can you bring up the Internet?  If not, outlook will not work because there is no 
transport. Try to reboot, but if you still can’t reach the Internet, then the state server is 
down. 
 
 



• My computer is acting sluggish.   
Reboot, or restart. NT fills memory in sequential order, and needs to emptied 
completely every once in a while. 

 
• It takes a long time for my account to come up when I log on. 

You may have filled the temporary Internet folders if you do a lot of surfing on the 
net. To empty, right click on the start menu and choose explore. Scroll to your 
account profile, and expand the temporary Internet files. Delete files with names like 
“Gdy7c063” and “w7m3kpwj” by right clicking on the file name, and choosing 
delete. Don’t forget to empty your recycling bin. 
  

• My computer is frozen! 
Don’t just shut it off! Hold down CTRL and ALT while clicking delete. Click on task 
manager, and see what applications are running. Highlight an application, and click 
end task.  A dialogue box may appear. Continue to tell it to end task, until that 
stubborn application stops.  If all else fails, use the reset button. 
 



OFFICE 
 

Short Cut Keys



 
Key Commands Short Cuts for Windows 95 Applications 
 
Ctrl + P  Print 
Ctrl + S  Save 
Ctrl + A  Select All 
Ctrl + Z  Undo 
Ctrl + X  Cut 
Ctrl + C  Copy 
Ctrl + V  Paste 
Ctrl + B  Bold 
Ctrl + I  Italic 
Ctrl + U  Underline 
Ctrl + F  Find 
Ctrl + H  Replace 
Ctrl + N  New Document 
Ctrl + O  Open 



PRINTING 
 
Problems



Printer Won’t Print 
 
A printer that won't print is usually easy to fix. There are only a handful of things that may be wrong. 
 
Verify that the printer is turned on. 
 
It sounds silly, but check this first. 
 
Verify that the printer is cabled correctly. 
 
Make sure the cable that connects your computer and printer is firmly plugged into both the computer and 
the printer. There's often more than one socket plug, or port, on the back of your computer into which the 
printer cable plugs. Make sure that you're plugging the printer cable into the correct port. Usually your 
printer cable plugs into the LPT1 port. 
 
If you're printing over a network, of course, the printer may be connected to another computer that serves 
as the print server, so check the printer connections with this computer, and make sure your computer is 
connected to the network. If you suspect a network problem, check out the topics about sharing a printer 
over a network, or harass your network administrator. 
 
Verify that the printer is online. 
 
There should be an "online" light somewhere on the front of your printer, indicating that your printer is 
ready and willing to accept information from your computer. This light should be on. If it isn't, put the 
printer online. You can usually do this by pressing the Online button or the Reset button. If you can't find 
either of these buttons on your printer, refer to the user guide that came with your printer. 
 
Add the printer if you haven't already. 
 
In Windows 95, you need to add a new printer before you can use it. Use a wizard to help you add a new 
printer.  
 
To add a new printer 
 

1.  Click the Start button, move the mouse over Settings, and click Printers.  
 
The Printers window opens. 
 
2.  Double-click the Add Printer icon to open the Add Printer Wizard.  
Follow the instructions in the Add Printer wizard as it steps you through the process of adding and 
describing your new printer. 

 
Is your printer broken?  
 
If none of the solutions described here work, it's possible that your printer is broken. In this case, there's 
nothing you can do from inside Windows 95. If you've tried everything and failed, try to print a test page, 
which you can usually do using a button on your printer (refer to your printer user guide if you don't see an 
obvious "Test" button on the printer's control panel). You may also want to follow any troubleshooting 
directions described in your printer user guide. 



Cancel Printing 
 
If your printer is functioning correctly, most printing problems are related to the complexity of the 
document you're trying to print. Here are a few strategies to get you out of a slow print job: 
 
Cancel printing from within the application 
 
As long as the application displays a message on the screen that says it's printing the document, that 
application is controlling your print job. If the application is taking too long, you might be able to cancel 
the job from within the application. Just click Cancel in the Print dialog box. 
 
Cancel printing from Windows 95 
 
Once the Print dialog box disappears and the active application returns to normal, your document--now in 
the form of a "spool file"--is in the hands of Windows 95. You can initialize printing by more than one 
application at a time, so printing in general may be slowed by the number of spool files being sent to 
Windows 95 at one time. 
 
To cancel printing from Windows 95 
 
1. Click the Start button, move the mouse over Settings, and click Control Panel. 
2. Double-click the Printers folder, and double-click the icon for the printer to which you sent the 

document. 
3. Select the printing document you want to cancel. 
4. Choose Cancel Printing from the Document menu. 
 
Tell Windows 95 to retry 
 
Windows 95 expects to send data to your printer on a regular basis (often every 45 seconds). If a "slow" 
document--such as one that includes color and graphics--is taking a long time to print, it prevents Windows 
95 from sending the printer more information. Windows 95 might conclude that your printer isn't 
responding and will stop sending data to the printer. 
 
To tell Windows 95 to start printing again, display the printer folder window as described above, and 
choose Pause Printing from the Printer menu; or try clicking Retry if it appears in the message box. (To 
display the printer folder window, start Windows Explorer, open the Printers folder by clicking it, and then 
open the stalled printer by double-clicking it. If there are still several pages left in the presentation, you 
might need to either choose Pause Printing from the Printer menu or click the Retry button a few more 
times. 
 
Increase the printer's Transmission Retry setting 
 
If you're frequently getting the "Printer isn't responding" message or if you're going to be printing a lot of 
graphics, you can tell Windows 95 that it's OK that your printer isn't quite as quick as Windows 95 would 
like it to be.  
 
Check the Available Printer Memory setting for the printer 
 
Windows 95 conservatively estimates the amount of memory available in your printer and breaks your 
document data up so that it won't overwhelm the printer. Make sure Windows 95 is taking advantage of all 
the memory in your printer. 
 
 
 
Remove problem graphics 
 



If your document prints up to a certain page and then hangs up, first make sure the printer hasn't just run 
out of paper. Then take a look at what's on the page that won't print. Try removing any graphics on that 
page and printing the page again. Encapsulated PostScript (EPS) graphics won't print at all on printers that 
aren't PostScript-compatible, and a bad or corrupted EPS graphic can cause your printer to cycle endlessly. 
 
Check fonts 
 
If the fonts look different than you expect when you print your document, you're probably a victim of font 
substitution. (You can get an idea of what fonts Windows 95 considers to be "similar" by opening your 
Fonts folder and choosing the View menu's List Fonts By Similarity command.) If you want to correct this 
problem, you'll need to install the same font on your computer. 
 

 
 



Other Resourses 
 
• Help feature in the program 
• Web site for program (ie: Microsoft) or hardware (ie: HP for printers) 
 


